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FF Mister 

If you want to play a new game, you 
need someone to explain it to you, 
otherwise you have only half as much 
fun.
It’s similar with FF Mister K, because 
using it is much like playing a game.
Many things you find out by yourself, 
thanks to OpenType features they will 
happen automatically. But for some 
really special effects  you need a bit 
of extra info. That is what we want to 
give you in this user manual.

FF Mister K started with Kafka and 
his manuscripts. But by now it has 
become a steadily growing ‘K family’, 
and the latest offsprings – 
FF Mister K Dingbats – just arrived to 
dominate the pages of this manual. 
Enjoy it!

 K.
Lets play K together!

high, far away in the sky …

Да���� п����а�м K!

����, д��е�� b н���*

’ 

* Release of Cyrillics in 2010

2



“Two men were standing behind the grave  
  holding a tombstone between them in the air;   
  only just had K. arrived when they 
    thrust the stone into the earth and 
   it stood as if it were cemented there.” 
               Franz Kafka, ‘A Dream’.

A person called ‘K.’ can be found in 
different stories and novels of the  
Austro-Hungarian author Franz Kafka 
(1883–1924), who is considered to  
be one of the most influential writers  
of the 20th century.  
He wrote short prose, long stories and 
novels, many of which were never  
completed. Instead, they were collect-
ed by Kafka’s friend Max Brod and

published only after his death, contrary 
to the author’s request that they be 
destroyed. 
The manuscripts of the two best known 
novels ‘The Castle’ and ‘The Trial’  were 
the source of inspiration for the design 
of the typeface ‘FF Mister K’ and their 
main characters (K., Josef K.) gave it its 
name. 
While the starting point in designing  
FF Mister K was the study of letterforms 
in Kafka’s manuscripts, a digital font 
always has its own characteristics and 

a comparison with the original scripts 
shows that the result is not a simple 
imitation of Kafka’s handwriting.   
One of the main tasks was the transfor-
mation of the writer’s eccentric letters 
with their strong form and size varia-
tions into a character set that enables  
a balanced typographic flow.
In a script font with predominantly 
connected characters, there are usually 
low, medium and high connections. 

 

All basic glyphs of FF Mister K have 
these alternates – which make written 
words look naturally connected. The 
OpenType feature code can determine 
the context in which the different  
alternates are inserted and place them 
in the right order. 
To give the font more character,  also 
several hundred ligatures with ‘extraor-
dinary’ forms were made. Again, the 
OpenType feature code sees that they 
are inserted appropriately for different 
languages. 

Franz Kafka and Mister 
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v

  FF Mister K Regular
  FF Mister K Onstage
  FF Mister K Crossout

K ’ 
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The FF Mister K family contains three 
text fonts: FF Mister K Regular, Onstage 
and Crossout.

The Regular is a relaxed ‘everyday’ 
writing style – Mister K  writing down 
something for himself or to a good 
friend. The glyphs are fluently con-
nected and have lots of form variations 
without added decorative elements.

The Onstage is Mister K’s writing style 
for less private purposes – special 
events and persons: Generally more 
calligraphic, the glyphs have elaborate 
details especially in the capitals and 
swashes at the word endings. 

The Crossout, finally, shows Mister K’s 
writing when fully dissatisfied with 
his work – all the words of the text are 
meticulously crossed out. For especially 
curious readers texts in ‘Crossout’ are 
still readable.

Three Ways of  Writing

Personality & Variety1

Personality & Variety2

Personality & Variety 3

1  FF Mister K Regular

–  casual writing with lots of ligatures and  

   alternate characters for creating a natural 

   and fluent looking text

–  underlining and crossout functions for 

   individual words 

–  mathematical signs

–  extra set for acronyms and formulas

– case sensitive function

–  more than 1500 glyphs

2  FF Mister K Onstage  

–  more calligraphic features 

–  less connected than Regular 

–  swashed caps and endings  

–  underlining and crossout functions for 

   individual words 

–  mathematical signs

–  extra set for acronyms and formulas

– case sensitive function

3  FF Mister K Crossout 

–  crossout function for long stretches of text

–  underlining and crossout functions for 

   individual words 

–  mathematical signs

–  extra set for acronyms and formulas

– case sensitive function

FF Mister  Onstage

FF Mister  Crossout

FF Mister  Regular
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Nice warm evening in Aabenraa (EU)

Nice warm evening in Aabenraa (EU)

Nice warm evening in Aabenraa (EU)All FF Mister K fonts are in OpenType 
format and work with both Mac OS X and 
Windows. Special OpenType features 
are included, which determine the fonts’ 
behaviour in different contexts. 
Most of the coding for this is located in 
the features Ligatures and Contextual 
Alternates. It’s usually best to keep these 
features turned on  – as they are by de-
fault. This will give you a result similar 
to the text in gold on the right. 
You can access these features like this:

InDesign: Window ▸ Type & Tables ▸ 
Character ▸ OpenType
Illustrator: Window ▸ Type ▸ Character ▸ 
OpenType
Photoshop: Window ▸ Type ▸ Character ▸ 
OpenType.

Sometimes you might want to see a word 
or part of it in the standard glyphs (in 
white on the right). This is how the font 
looks in applications like MS Word, that 
do not (yet) support OpenType layout 
features.
Finally, turning on Stylistic Set 1 (InDe-
sign) or Stylistic Alternates (Illustrator, 
Photoshop) leads to a set of simple, 
disconnected characters as shown in red 
on the right. They are meant mainly for 
abbreviations, names in all caps, scien-
tific formulas, etc.

OT Features / Default

Standard Set

With Contextual Alternates + Ligatures

Standard Set

• ••

Nice warm evening in Aabenraa (EU)
Stylistic Set 1 / InDesign

Stylistic Alternates / Illustrator, Photoshop

Nice warm evening in Aabenraa (EU)
Contextual Alternates + Ligatures

Nice warm evening in Aabenraa (EU)
Stylistic Set 1 / InDesign

Stylistic Alternates / Illustrator, Photoshop

FF Mister  Regular

FF Mister  Onstage
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a a a a a 

To connect the glyphs, FF Mister K makes 
use of an extended ligature feature code. 
On the right you see the word Handgloves 
as assembled by the ligature code. Further 
alternates for the glyph ‘a’ and alternate  
o-ligatures are shown in gold. They are 
used in other letter / word environments.

Should you have texts where numbers, 
formulas or acronyms play a major role – 
FF Mister K Regular and  FF Mister K On-
stage can help out with these OpenType 
features:

OT Features / Glyph Connections

Fractions: 41/2 → 41/2, 85/6 → 85/6
Subscripts: CO2 → CO2
Superscripts: 133Xe → 133Xe
Ordinals: 2a → 2a, 1o → 1o
Slashed Zero: 100 → 100
Alternates: 22222 → 22222
Case Sensitive:“UNEP”→“UNEP”

ov os or od 
om ol ok on 
oy op ox 
ow oz oi  � 
� � � � 
� � � 
� ou oo …

Alternates for ‘a’ 

Ligatures with ‘o’
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Of course you can write without mis-
takes. But with FF Mister K you can also 
pretend to be really writing by hand and 
show your mistakes purposely. Show the 
work in progress and the editing  and 
correction marks of your first draft …
Play with meaning, play with language, 
play with the font! 

The effects shown on the right are avail-
able for all three FF Mister K text fonts. 
The described key combinations are  
hit 2–5 times to get the effects in differ-
ent lengths. 
These key combinations work with Mac 
OS X and Windows – with the exception 
of the wavy underline. To get it using 
Windows, you instead double click 
almost equal (≈) in the glyphs panel 
(InDesign, Illustrator) 2–5 times, and 
with the contextual alternates turned on 
it will turn into a wavy underline. 

OT Features / Special Effects

 Contextual alternate for endash (alt + -)

 Contextual alternate for underscore (shift + -)

 Contextual alternate for almost equal (alt + x)    

 Contextual alternate for equal

 Contextual alternate for emdash (alt + shift + -)
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FF Mister  Regular OT / Pro
 Quick and easy shopping in different languages 

at the Vaalimaa————— border crossing. 
 Belgia ja eraannetajate toel te�s saanud 

polaarjaamale on eesmärgiks seatud nulltasemel 
emissioon.  Le Charme Discret de la Bourgeoisie
  Støvet inneholder jern som fungerer====== som  

gjødsel på havet. Fenomenet vi har illus- 
trert gjennom eksperimentet vårt er noe som 
oppstår≈≈≈≈≈≈ gradvis over tusenvis av år. 
 Uno de los causas postuladas es la emisión 

indiscriminada de gases invernadero a la atmósfera. 
El discreto encanto de la burguesia:  Ha, denk je 
dan, het gaat de g�de kant op. Maar ____ wat blijkt: 
Zo  kun je  jezelf mooi voor de gek houden.  „Was 
sagtest du?“ fragte ihn die Gewalt. Als Herr Keuner 
weggegangen war,  fragten ihn –––– seine Schüler nach 
seinem Rückgrat. 

Here’s the Regular in different languages 
with the contextual alternates and liga-
tures turned on to include correction  
effects typical for informal handwriting.
As shown below, all three FF Mister K text 
fonts have a wide language support:

Galician
German
Greenlandic
Icelandic
Indonesian
Interlingua
Irish
Italian
Karaim, Latin
Low German
Luxembourgian
Malagasy
Malay, Latin
Manx Gaelic
Norwegian
North Frisian
Northern Sotho
Occitan
Portuguese
Rhaeto-Romance

Afrikaans
Albanian
Arvanitika, Latin
Asturian
Baraba Tatar
Bislama
Breton
Catalan
Chamorro
Danish
Dutch
East Frisian
English
Estonian
Faeroese
Finnish
Franco-provençal
French
Frisian
Friulian

Additional Support by OpenType Pro
Arumanian
Basque
Bosnian, Latin
Belarussian, Latin
Cook Islands Maori
Crimean Tatar, Latin
Croatian
Czech
Esperanto
Gagauz, Latin

Hawaiian
Hungarian
Inari Sami
Istro-Romanian
Kashubian
Kurmanji
Latvian, Lettish
Lithuanian
Lule Sami
Maltese
Maori
Marshallese
Moldavian, Latin

Polish
Romanian
Samoan
Serbian, Latin
Slovak
Slovenian
Sorbian
Tongan
Turkish
Ubykh
Våmhusmål
Vepsian
Wallisian

Language Support by OpenType Standard
Romansch
Scottish Gaelic
Somali
Southern Sami
Southern Sotho
Spanish
Swedish
Tagalog
Tahitian
Tsakhur, Latin
Tsonga
Tswana
Ume Sami
Walloon
West Frisian
Xhosa
Yapese
Zulu
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Philosophical in Regular Pro
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Aber jeden Tag soll 
zumindest eine Zeile 

gegen mich gerichtet werden 
wie man 

die Fernrohre jetzt gegen den 
Kometen richtet.

There’s a sample text of FF Mister K 
Onstage on the right – less connect-
ed than the Regular but with more 
pronounced decorations and swashes 
at the end of the words. 
– Mister K trying its best to make a 
good impression. 
Remember that it’s always possible 
to turn off the OpenType features 
or activate Stylistic Set 1/Stylistic 
Alternates, should you be searching 
for more simple letter forms.

Every day at least one line of text shall     be directed against—————— at  me  as——— like telescopes are nowadays directed aimed at       the comet.

  FF Mister K Onstage

Franz Kafka, Diary, (above original in FF Mister K Onstage, below translation in FF Mister K Regular, FF Mister K Crossout)  
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Ornaments in Onstage Pro

Onstage is not only a text font. It also 
contains a lot of ornaments which  
can be accessed from the glyphs panel 
in InDesign and Illustrator. – As was 
done on this and the previous page.
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 Con immissione di gas , tecnica molto usata     
 che impiega bombole con valvole a rilascio 
controllato o nei metodi fai da te con 
 fermentazione di varie sostanze che produrranno 
in se—————g—————uit——————o—————— ——————i————l  gas.  Gode transportmuligheder 
er en central forudsætning for videreudviklingen 
af et modernesamfund.  Savukārt CO2 tiek 
 savāks====== un noglabāts sāļūdens≈≈≈≈≈≈ akvatori�
jās, pazemē vai iepumpēts dziļi 
okeānā, kur lielā spiediena un aukstās 
tem pe ratūras rezultātā ogleklis 
sašķidrinātos un uz mūžiem paliktu nog�
labāts. 

 De acordo com o relatório publicado nesta 
terça_____ pela____ Agência Ambiental de Avaliações 
da Holanda, a China passou os EUA como–––– hiophi�
omaior––––– emissora de CO2   Skupina ČEZ plánuje 
do roku 2008 ztrojnásobit výrobu z obnovitelných 
zdrojů energie.

FF Mister K Crossout Pro in action: 
Crossout is similar to the Regular 
but somewhat difficult to read due 
to heavy crossing out. It gets fully 
unreadable when the contextual 
alternates feature is turned on and 
the crossout effect is used over and 
over again (see right).

We suggest to use the style sparsely 
to catch curious people’s attention 
to cryptic pieces of information.

FF Mister K Crossout Pro
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14



QWp07

       Rovaniemi, 4.12.Hei,d73!
 Yesterday I had an unpleasant meeting with
our Qp14. But o.k. no work today - so I slept long 
till d11, took an endless QK and bad habit - 
sm�ed d19 Qo60 already before f72.
 Nice idea: Let ’s meet and have a couple 
� Qf23 and some Qf66 when you come back. 
 Are you taking a Qt27 or Qt05d30Qt20? 
And have you found someone to look after your
Qa15Qa13 and Qa07? Or are they travelling 
with you? 
 Sure hope you have better Qw06 down there 
in c70. Here I wouldn’t mind some Qw03

�  this disgusting Qw02.

FF Mister K Dingbats are the new-
comers to the Mister K Family. It 
started with Finnish illustrator Oili 
Kokkonen creating some pretty 
funny cartoon characters using let-
terforms of FF Mister K Regular.

Soon after, the design of almost 
600 pictograms was on its way. 
All are based on glyph parts of the 
Regular with which they make a 
very good match. 

FF Mister  Dingbats
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QWp07

    One morning d05as 
 Gregor Samsa woke up 
from anxious dreams, 
   he discovered that 
  in hisp04 he had been 
    changed into a monstrous 
  verminousa01.

Franz Kafka, Metamorphosis, 1915

The Dingbats in Text

Pictograms and text are readily 
combined – as shown in one of 
Kafka’s stories here.  It is fun  
to do layouts like this. Although  
the pictograms are constructed 
from forms coming from the Regu-
lar, also integrating them in On-
stage texts works very well. Base-
line shift lets you easily move them 
up and down.

It’s a game not just for designers 
but for anyone writing – a letter, a 
birthday card, a party invitation …
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QWp07

72 pictograms can be directly 
accessed with a keystroke, and all 
596 can be accessed with their 
keycode, consisting of a letter fol-
lowed by a double-digit number.  
To make it easier to remember, 
the letter in the beginning is taken 
from the name of the group (see 
right).
A complete list of the groups with 
all the pictograms plus keycodes 
is on page 23 and the ones follow-
ing it.

Dingbat  Theme Groups

a = animals, plants

c = cities, countries’ flags

d = dingbats

f = food, dishes

h = household, garden

l = leasure, sports, vacation

o =  office, technics, work

p = people

t = transport

w = weather

a04

c06

d01

f03

h02

l01

o10

p02

t01

w04

a03  

  f22         f23  f24 f25 f26           f27                      f28 f29             f30        f31       f32    f33      f34         f35      f36 f37  f38  
     f39    

a for animal

f for food

  They all start with “f” – so what 
kind of food  is in them ?? Qd74

a03
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QWp07

Accessing the K. Dingbats

Keystroke  Hit a key on the keyboard 
and most likely an animal, a car, building 
or something similar will appear on
your screen. Easy, but like this you can 
enter only 72 pictograms out of 596, 
and the ones you are looking for might 
not be obtainable in this way.

Keycode  There’s an overview of all 
FF Mister K Dingbats on pages 23–31 
of this manual. Check the theme groups 
to find the pics in the alphabetical 
order of their names and numerical  
order of their keycodes. 
Example: f01 = apple; f02 = avocado. 
Write the code, and the pictogram ap-
pears in the text box your cursor is in. 
(Standard ligatures turned on.)

Glyphs panel  Open the glyphs panel
in different applications like this:
· InDesign: Window ▸Type & Tables ▸     
  Glyphs 
· Illustrator: Window ▸Type ▸ Glyphs
· QuarkXPress: Window ▸ Glyphs
· TextEdit: Edit ▸ Special Characters.
Here you can see all 596 of them. Choose 
Sort by CID/GID from the panel menu to 
see the pics arranged in accordance with 
the theme groups. Keep your cursor in 
the text box and double click an icon in 
the glyph panel to insert it.

1 2
3

a05    →     a05
c05    →      c05

Three ways to get  
     to the  Mister K Dingbats:

A    →     A
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QWp07

Dingbats for Illustrations

‘t ’ for transp�:
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QWp07QW O X V E

FF Mister  Dingbat Extras

Q 

Background? Frame? Checkmark? 
Get the same natural look as in  
FF Mister K text fonts – just hit the 
key for the elements you need or 
select them from the glyphs panel 
– and they appear one beside the 
other in the text box.

W O X V E
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QWp07

 .X .X . X

h14OE h14OE h14 OE

 zOX zOX z OX

Working with Editing Marks

     c17O  d65 X  c42VV     q E   a12E    f54 OX     o57 OE

Getting one or more editing marks  
on top of each other in different  
colours is easy if you follow the three 
steps shown here. 

21

Step 1: pictogram ▸ editing mark
First select pictogram then the mark 
(circle, checkmark, etc.) from glyphs 
panel or enter by keycode.

Step 2: colour
Choose colours.

Step 3: ot Feature
Turn on: Stylistic Set 1 (InDesign) 
or Stylistic Alternates (Illustrator, 
Photoshop): The selected elements 
slide over each other.

→

→

→

→

→

→



QWp07

 

Qd69 Qd69 Qd69

Wa10 Wa10 Wa10

QWc17 QWc17 QQWQWc17

QWc42V QWc42V QWc44V

Working with Background Box and Frame

Qc17  QW.  Qc42  QWc42  QWa10  Qc17O  Qd72X  QWc17O  QW.X  QWzE  Qc42V  Wa10E

Step 1: box ▸ Frame ▸ image ▸ editing mark
First select the elements you need 
in the above order from glyphs panel 
or enter by keycode.

Step 3: ot Feature
Turn on: Stylistic Set 1 (InDesign) 
or Stylistic Alternates (Illustrator, 
Photoshop): The selected elements 
slide over each other.

If you want to use the background 
box and/or frame make sure you enter 
the elements in the order: 
1. box, 2. frame, 3.image, 4. editing 
mark. Then use colour and layer the  
elements on top of each other  
(step 2, 3).

Step 2: colour
Choose colours.

→

→

→

→

→

→

→

→
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QWp07 a01 beetle  

 a02 beetle, upside-down  

 a03 butterfly 

# a04 cat  

 a05 cow 

 a06 dog  

* a07 dog, sitting  

 a08  dove, collared  

 a09  fish  

 a10  gull  

 a11  hare  

 a12  hen  

  a01  
 a02  
 a03  
  a04    
 a05  
  a06    
   a07      
 a08       
 a09     
 a10     
 a11     
  a12     

 a13    
 a14     
  a15     
 a16     
 a17     
 a18     
 a19    
  a20
 a21

 a22
 a23
 a24 

 a13  rooster 

 a14  horse  

 a15  penguin  

 a16  pig  

 a17  sheep  

 a18  snake  

 a19  tiger 

 a20 ash 

  a21  bell flower 

 a22 birch 

 a23 calendula 

 a24 cannabis 

 a25
 a26

 a27
 a28
 a29
 a30
 a31
 a32
 a33
 a34
 a35

 a25  lime tree  

 a26 maple 

 a27 nettle 

 a28 oak 

 a29 plantain 

 a30 rose

 a31  spruce tree  

 a32  sunflower 

 a33  tulip  

 a34  violet 

 a35 walnut

FF Mister  Dingbats Overview

An overview of all FF Mister K Dingbats: 
There are 11 groups covering different  
topics. In the groups, the images are  
arranged in the numerical order of their 
keycodes. From left to right you find:

pictogram  |  keystroke  |  keycode |  name

  a04                   #                     a04            cat

  Q 

  W  

    V

  O     

   E     

  X    

Q  Background box

W  Background frame

V  Checkmark

O  Circle 

E  Crossout

X  X mark

 A...  Animals & Plants
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QWp07

c01
c02      
c03          
c04        
c05        
 c06        
c07 
c08 
c09 
c10  
+
c12       
c13       
c14       
c15         
c16 
c17      
c18  

 c01 Amsterdam, Skinny Bridge  

 c02  Athens, Parthenon 

 c03  Barcelona, Holy Family Church 

 c04  Berlin, Brandenburg Gate 

 c05  Berlin, House of World Cultures 

 c06  Berlin, TV Tower 

 c07  Bratislava, Castle  

 c08  Bucharest, Parliament Palace

 c09  Budapest, Buda-Castle

 c10  Buenos Aires, Woman’s Bridge 

+ c11 Cairo, Sphinx and Pyramid

 c12 Chicago, Cloud Gate 

 c13 Copenhagen, Little Mermaid 

 c14  Dessau, Bauhaus  

 c15  Hamburg, Concert Hall  

 c16  Havana, Malecon 

 c17  Helsinki, Cathedral 

 c18  Hollywood  Hill

c19  
c20      
c21   
c22        
c23    
c24  
c25         
c26
c27      
 .
c29           

c30         
:  
 c32         
c33          
 c34      
c35 
c36      
 c37 
c38  

, c19  Istanbul,  Blue Mosque

 c20  Lisbon, Pantheon

 c21  London, Tower Bridge  

 c22  Madrid, Alcala Gate 

 c23  Mexico, Metropolitan Cathedral 

 c24  Montreal, Olympic Stadium 

 c25  Moscow, St. Basil’s Cathedral

 c26 Moscow, Kremlin

 c27 Moscow, University

. c28  New York, Statue of Liberty  

 c29  Oslo, Holmenkollen 

 c30  Paris, Eiffel Tower  

: c31  Peking, Gate of Heavenly Peace

 c32  Philadelphia, Liberty Bell 

 c33  Pisa, Leaning Tower  

 c34  Prague, Powder Tower  

; c35 Rio de Janeiro, Christ Redeemer 

 c36 Rome, Colosseum  

 c37  Rotterdam, Erasmus Bridge

 c38  San Francisco, Golden Gate Bridge

c39  
c40 
c41  
c42  
c43 
c44     
c45  
c46
c47 
c48 
c49
c50  
c51  
c52  
c53 
c54 
c55  
c56 
c57 
c58 

 c39  Saint Louis, Arch 

 c40  Stockholm, Nordic Museum

 c41  Saint Petersburg, Palace Bridge 

< c42  Sydney, Opera  

 c43  Tokyo, Parliament Building 

 c44 Venice, Waterfront   

 c45  Vienna, Prater  

 c46  Warsaw, Palace of Culture  

 c47  Washington, Capitol  

 c48  Zurich, St. Peter’s Church

 c49 flag, Australian  

 c50  flag, Brazilian  

 c51  flag, British  

 c52  flag, Canadian  

 c53  flag, Chinese  

 c54  flag, Cuban 

 c55  flag, Czech  

 c56  flag, Danish 

 c57  flag, Dutch, etc.  

 c58  flag, Egyptian  

c59 
c60  
c61  
c62  
c63        
c64        
c65        
c66        
c67        
c68       
c69        
c70 
c71     
c72
c73
c74

 c59  flag, European  

 c60  flag, Finnish  

 c61  flag, Be, Fr, etc.  

 c62  flag, Greek  

 c63  flag, Be, Fr, etc. inverted  

 c64  flag, Japanese  

 c65  flag, Mexican  

 c66  flag, Norwegian  

 c67  flag, Polish  

 c68  flag, Portuguese 

 c69  flag, Spanish  

 c70  flag, Swiss 

 c71  flag, Turkish  

 c72  flag, USA 

 c73  Europe 

 c74  hammer and sickle 

 

 C... Cities, Countries & Flags
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QWp07

 d01  
 d02       
 d03       
 d04       
 d05       
 d06       
 d07       
 d08       
 d09       
 d10       
 d11       
 d12      
   d13
 d14     
 d15 
    d16    
 d17   
    d18

 d01  clock one  

 d02  clock two  

 d03  clock three  

 d04  clock four  

 d05  clock five  

 d06  clock six  

 d07  clock seven  

 d08  clock eight  

 d09  clock nine  

 d10  clock ten  

 d11  clock eleven  

 d12  clock twelve 

 = d13  circle zero  

 ! d14  circle one 

" d15  circle two 

§ d16  circle three

$ d17  circle four  

% d18  circle five 

d19  
d20 
(
)
d23 
d24 
d25 
d26 
d27
d28 
d29 
d30 
d31  
d32
d33 
d34 
d35 
d36 
d37
d38

&  d19  circle six   

/ d20  circle seven  

( d21  circle eight   

) d22  circle nine   

 d23  circle ten    

 d24  circle eleven   

 d25  circle twelve   

 d26  circle thirteen  

 d27  circle fourteen  

 d28  circle fifteen 

 d29  circle empty 

 d30  circle arrow E  

 d31  circle arrow SE  

 d32  circle arrow S  

 d33  circle arrow SW 

 d34  circle arrow W  

 d35  circle arrow NW  

 d36  circle arrow N  

 d37  circle arrow NE  

 d38  circle arrow right up  

 d39  circle arrow right down  

 d40  circle arrow down right 

 d41  circle arrow down left  

 d42  circle arrow left down  

 d43  circle arrow left up  

 d44  circle arrow up left 

 d45  circle arrow up right 

 d46  circle plus  

 d47  circle minus 

 d48  circle multiply  

 d49  circle divide  

 d50  circle equal  

 d51  circle three-pointed star  

 d52  circle four-pointed star  

 d53  circle five-pointed star  

 d54  star three-pointed   

 d55  star four-pointed  

 d56  star five-pointed  

 d57  stroke one  

 d58  stroke two  

d39 
d40  
d41
d42 
d43
d44
d45 
d46
d47 
d48
d49
d50
d51
d52
d53
d54 
d55
d56 
d57 
d58 

d59 
d60 
d61 
d62   
z     
y      
d65       
d66      
d67       
d68         
d69     
d70   
d71    
{    
d73       
d74       
|   
d76      
d77     
d78

 d59  stroke three  

 d60  stroke four  

 d61  stroke five  

 d62  smiley angry   

z d63 smiley broad smile 

y d64 smiley cool   

 d65  smiley crying  

 d66  smiley embarrassed  

 d67  smiley gasp  

 d68  smiley happy     

 d69  smiley innocent  

 d70  smiley neutral

 d71  smiley  round mouth 

{ d72 smiley unhappy   

 d73  smiley tongue  

 d74  smiley  perplexed 

| d75  smiley wink  

  d76  smiley worried 

 d77  play  

 d78  fast forward  

 D...  Dingbats, Symbols
d79     
d80   
d81     
d82     
d83  
d84     
d85       
d86     
d87       

 d79  rewind  

 d80  fast rewind  

 d81  pause  

 d82  eject  

 d83  slow motion  

 d84  loop  

 d85  on-off  

 d86  record  

 d87  stop-play  
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 f59  egg beater  

 f60  fried egg 

 f61  french bread 

 f62  french fries  

 f63  frying pan  

 f64  grater  

 f65  hand mixer 

 f66  hot dog 

 f67  ice cream 

 f68  ice, soft ice  

 f69  jug, milk pitcher 

 f70  jug, tea jug 

 f71  kettle  

 f72  meal, egg  

 f73  meal, fish 

 f74  meal, meat 

 f75  meal, pizza 

 f76  meal, sausage 

 f77  meal, vegetarian 

  f78  plate   

 f79  plate, fish 

 f80  plate, fried chicken  

 f81  plate, pork knuckle  

 f82  plate, shrimp  

 f83  plate, suckling pig  

 f84 pizza slice 

 f85 pot  

 f86 pretzel 

 f87  rice noodles 

 f88  shake  

 f89  soup 

 f90  sushi  

 f91  oil and vinegar set  

 f92  salt and pepper 

 f93  salt pours 

 f94  sugar jar  

 f95  sugar sprinkler  

 f96  toaster  

 

 f01 apple  

 f02  avocado  

 f03  banana 

 f04  carrot   

 f05  cherry  

 f06  coffee beans  

 f07  corn  

 f08  cucumber 

 f09  eggplant 

 f10  garlic 

 f11  grapes 

 f12  lemon 

 f13  lobster 

 f14  mushroom  

 f15  orange 

 f16  pear  

 f17  peppers 

 f18  pepper green

 

 f19  radish  

 f20  strawberry 

 f21  tomato  

 f22  bottle  

 f23  bottles, two 

 f24  bottle, baby  

 f25  bottle, beer  

 f26  bottle, champagne 

 f27  bottle, milk   

 f28  bottle, soda 

 f29  bottle, sparkling wine  

 f30  bottle, sport 

 f31  bottle, wine 

 f32  glass, beer

} f33 glass, beer jug  

 f34 glass, champagne 

 f35  glass, cocktail 

 f36  glass, martini  

 f37  glass, sparkling wine 

 f38  glass, wine

 f39  glass, wine, round 

 f40  bottle opener  

 f41  corkscrew 

 f42  bread  

 f43  bun  

 f44  burger  

 f45  cake, birthday cake  

 f46  cake, cream cake  

 f47  cake, cupcake 

 f48  cake, mini cake  

 f49  cake, piece of cake  

 f50  cake, roll-cake  

 f51  cheese  

 f52  coffee jug 

 f53  coffee mill  

 f54  coffee pot 

 f55  coffee to go  

 f56  croissant  

 f57  cup

 f58  egg boiled  

f01    
f02     
f03    
f04      
f05     
f06       
f07     
f08    
f09    
f10    

f11    
f12    
f13    
f14   
f15   
f16    
f17    
 f18

      

f19     
 f20    
f21   
 f22    
f23    
  f24    
 f25    
 f26   
 f27     
 f28   
   f29    
 f30   
   f31   
 f32  
 f33  
f34  
f35   
f36    
 f37   
 f38  

 f39    
f40    
f41   
f42    
f43    
f44    
f45    
f46    
f47   
f48    
f49    
f50    
f51    
f52   
f53    
f54   
f55    
f56    
f57  
 f58    

 F... Food & Dishes
f59    
f60   
f61   
f62  
f63    
 f64    
f65   
f66   
 f67   
 f68    
f69  
f70  
f71   
f72    
f73   
f74   
f75   
f76   
f77   
f78   

f79  
f80  
f81    
f82    
f83    
f84  
f85   
f86  
f87   
f88    
f89   
f90    
f91  
f92   
f93   
f94    
 f95    
f96  
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 l01 badminton  

 l02  baseball  

 l03  basketball  

 l04  bowling  

 l05  darts  

 l06  diving  

 l07  fitness training  

 l08  football soccer  

 l09  football american   

 l10  helmet  

 l11  ice hockey  

 l12  inliner  

 l13  nordic walking  

 l14  skateboard  

 l15  skating  

 l16  tennis  

 l17  volleyball  

  l18  bag  

 l19  basket  

 l20  bathing area  

 l21  binoculars  

 l22  book  

 l23  book inside  

 l24  book of K  

 l25  camera  

 l26  camera digital 

 l27  camera video 

 l28  campfire  

 l29  campsite  

 l30  castle 

 l31  compass German  

 l32  compass English 

 l33  discount  

 l34  guitar  

 l35  hour glass 

 l36  joker  

 l37  life vest  

 l38  lighthouse  

 l39  locker  

 l40  lost and found  

 h01 alarm clock  

 h02  armchair  

 h03  bathtub  

 h04  buggy  

 h05  house  

 h06  garage 

 h07  cloak-room  

 h08  key 

v h09  light bulb  

x h10 light bulb, low energy 

 h11 microwave  

 h12  piggy bank  

 h13  radio  

 h14  recycling 

 h15  refrigerator  

 h16  scales  

 h17  sofa  

 h18 stove  

 h19  table lamp  

 h20 telephone old   

 h21 TV  

 h22  TV modern  

 h23  washing machine 

 h24  broom  

 h25  cleaning mop  

 h26  drill  

 h27  hammer  

 h28  hoe  

 h29  pail  

 h30  pliers  

 h31  rake  

 h32  saw  

 h33  screwdriver  

 h34  shovel  

 h35  sickle  

 h36  tools  

 h37  water can  

 h38  wet paint 

 h39  wrench

 l41 luggage cart  

 l42 mask  

 l43  meeting point  

 l44  money exchange  

 l45  cash machine  

 l46  music   

 l47  shopping bag  

 l48  shopping basket  

 l49  shopping cart  

 l50  suitcase  

 l51  telephone booth 

 l52  theatre  

 l53  violin 

\ l54  info    

] l55 closed   

^ l56 open   

_ i57 sale   

b l58 sign empty  

e  l59 unbelievable  

g l60 WC    

l01   
l02   
l03   
l04   
l05   
l06   
l07               
l08
l09  
 l10  
l11 
l12  
l13  
l14   
l15   
l16   
l17   
 l18   
l19   
l20  

l21   
l22   
l23   
l24  
l25   
l26 
l27 
l28   
l29   
l30  
l31   
l32 
l33 
l34 
l35 
l36   
l37   
l38  
l39  
l40 

l41 
l42    
l43    
l44    
l45    
l46     
l47    
l48    
l49    
l50    
l51   
l52    
l53   
l54   
l55   
l56   
_ 
l58  
l59  
l60  

 H... Household
 h01   
h02    
h03    
 h04    
h05    
h06   
h07    
 h08   
 h09    
  h10  
h11    
h12    
h13    
h14   
 h15    
 h16    
h17    
 h18    
h19

 

h20

h21    
h22    
h23   
h24   
h25   
h26   
h27   
h28   
h29   
h30   
h31   
h32   
h33   
h34   
h35   
h36   
h37   
h38
h39  

L... Leisure, Sp�s, Vacation
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  o01 attachment  

 o02  battery empty 

 o03  battery half full  

 o04  battery full   

 o05  beamer / projector  

 o06  bomb, crash  

 o07  business card  

 o08  calendar  

 o09  CD  

 o10  clipboard  

 o11  electricity, socket  

 o12  envelope  

 o13  envelope narrow  

 o14  factory  

 o15  fax  

 o16  film camera  

 o17  filofax  

 o18  fire extinguisher  

 o19  folder  

 o20  garbage can 

 o21  garbage can full  

 o22  glasses  

 o23  globe  

 o24  growth curve  

 o25  headphones  

 o26  headset  

s o27  heart 

 o28  heart Cupid’s arrow 

u o29  heart broken 

 o30  hyperlink  

 o31  ink pen  

i o32  smartphone  

j o33  audio player  

 o34  laboratory  

 o35  laptop  

 o36  laptop wireless 

 o37  link closed  

 o38  link open  

 o01   
 o02  
 o03   
 o04    
o05   
o06    
o07    
 o08    
 o09    
 o10    
o11    
o12    
o13    
o14    
o15    
o16    
o17    
o18 

   

o19    
o20 
o21   
o22   
o23   
o24   
o25   
o26   
o27  
o28  
o29  
 o30   
o31   
i   
j   
o34   
o35   
o36  
o37   
o38   

 o39  lock closed  

 o40  lock open  

  o41  Maggie’s apple  

 o42 marker  

 o43  megaphone  

 o44  microphone  

 o45  mobile phone  

 o46  notepad  

 o47  office chair  

 o48  PC mouse  

 o49  pencil  

 o50  pistol  

 o51  printer  

 o52  question

 o53 record 

k o54 scissors 

m o55  scissors half, no dots

n o56  scissors half with dots   

 o57  security camera  

q  o58  skull

r o59  skull and crossbones  

 o60  smoking  

 o61  solar energy 

 o62  sound  

 o63  sound loud  

 o64  sound off  

 o65  speaker  

 o66  speech balloon  

 o67  speech balloon empty  

 o68  stamp  

 o69  telephone cordless  

 o70  telephone receiver  

 o71  trial  courthouse

 o72  typewriter 

 o73  USB stick  

 o74  watch   

 o75  wind energy 

 o76  zoom in  

 o77  zoom out 

 o39   
 o40   
 o41
o42   
o43   
 o44    

 o45    
o46    
 o47    

 o48    
 o49    
o50    
o51    
o52  
o53  
o54  
o55  
o56    
o57   
 q  

r    
o60    
o61  
o62 
o63   
o64  
o65  
o66  
o67 
o68  
o69  
o70  

o71  
o72  
o73  
o74    
o75  
o76 
o77

   O... Office, Technics, Work
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p01  
p02  
p03  
p04   
p05   
p06   
p07   
p08   
p09   
p10   
p11   
p12   
 p13   
 p14  
p15  
p16   
p17  

p18

   

 p01 baby  

 p02 beach man  

 p03 beach woman  

 p04  bed, accomodation 

 p05  bike with man  

 p06  bike with woman  

 p07  bubbler  man

H p08  changing booth  

I p09  changing men  

J p10  changing women  

 p11  conference men  

 p12  conference women  

 p13  cook  

 p14  detective 

 p15  dinghy 

 p16  doctor male  

 p17  doctor female 

 p18  elevator  

p19   

p20
 p21   
p22   
p23  
 p24  
 p25   

p26    
p27    
p28    
p29    
p30    
p31 
p32    
p33    
p34   
 p35    
 p36   
p37    
p38     

 p19  escalator down  

 p20  escalator up  

 p21 family  

 p22  general 

 p23  hospital patient

 p24 nurse  

 p25  safety belt  

K p26  shower men  

L p27  shower women  

 p28  ski jump  

 p29  ski man  

 p30  ski woman  

 p31  slippery floor  

 p32  swimming man  

 p33  swimming woman  

M p34  toilet men, women  

N p35  toilet men  

P p36  toilet women  

 p37  waiting room  

 p38  waste basket  

 p39  windsurfer

 p40 wheel chair  

 p41 wheel chair ramp  

 p42 work site man 

 p43 work site woman 

Z p44  gender female   

Y p45 gender male 

R p46  hand down 

S p47 hand up     

 p48  hand first aid  

T p49  hand pointers  

U p50 hand shake 

 p51  hand washing  

[ p52  hand writing  

p39
p40
p41 
p42  
p43  
 Z  
 p45 
 p46  
 p47 
p48   
p49 
U 
p51   
 [   

P... People, Professions

QWp07
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  t01  ambulance  

  t02  balloon  

>  t03  bike women  

  t04  bike men 

  t05  bus  front

@  t06  bus side  

  t07  cabriolet  

A  t08  car  

  t09  car with luggage  

  t10  caterpillar 

  t11  cement truck  

  t12  fire truck

  t13  helicopter  

  t14  jeep  

  t15  metro  

  t16  motorcycle 

  t17  pickup  

  t18  plane  

  t19  landing  

  t20   take off  

  t21   police car  

  t22   sailboat  

  t23   scooter  

  t24   ship  

  t25   small car  

  t26   sports car  

  t27   taxi  

  t28   trailer

B  t29   train  

  t30   train modern  

C  t31   truck old

  t32   truck modern 

  t33   customs Engl. Span. 

  t34   customs Ger. French

D  t35   direction left   

F  t36   direction right 

  t37   exit 

  t38   no entrance 

 t39  junction  

 t40  yield  

 t41  parking  

 t42  no parking  

 t43  parking disk  

 t44  sleeping car 

 t45  smog warning  

 t46  stop  

 t47  warning  

 t48  barrier 

 t49  gas station

 t01  

 t02  
>   
t04

t05  
t06  
t07  
A  
t09  
t10 
t11  
t12
t13  
t14  
t15  
t16 
t17  
t18 
 

t19  
t20  
t21  
t22  
t23   
t24    
t25    
 t26    
 t27  
t28 
t29  
t30   
 t31
t32 
  t33 
  t34
 t35 
 t36 
 t37 
 t38 

t39
t40  
t41  
t42  
t43  
t44 
t45    
t46  
t47  
t48 
t49
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    T... Transp�  W... Weather 
w01  
w02  
w03  
w04  
w05  
w06 
w07 
w08 
w09  
w10 

  w01 cloud  

  w02 rain  

  w03 snow  

  w04 sun  

    ~   w05 sun and cloud  

  w06 sun and rain  

  w07 thunder 

  w08 thermometer  

  w09 umbrella  

  w10 wind vane



QWp07

31

What is missing??

Mister K’s family still has room  
for development as a typeface and  
a graphical tool. 
More functional and curious styles and 
features are planned. And the repertoire 
of pictograms will grow in a topic  
specific way.
We are glad to get critique – so we  
can make FF Mister K as useful as  
possible. Also if you have ideas about  
what should still be included in the 
family: Tell us on Mister K’s own Website 
ffmisterk.com. 
– There you can see the  K family in full 
action once more!

ffmisterk.comExit →�²∂2Ψ
i�
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